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PRELUDE

Instant Music is for the musician in us all. If you find yourself strumming air during your favorite guitar riff, or
drumming along on your car steering wheel, but the only real musical instrument you can play is your sterco, then
Instant Music may be just what you've been waiting for.

Imagine yourself playing the lead guitar solo to your favorite tune, without making mistakes! With Instant Music
you don't need to know the rules of harmony, counterpoint, or rhythm to jam to the music. Instant Music lets loose
your creativity by keeping track of the rules for you. You can give yourself over to the tune that plays in your head.
If you're close, Instant Music will put you right on.

But Instant Music gives you a lot more than just jamming. You can write a full score for a set of three instruments
(which you choose from many), and the artificial intelligence built into Instant Music makes sure they play in tune.
Or you can use one of the many songs on the program disk as a template and add the notes, embellishments, and
refinements yourself. The templates have been constructed with the musical information already built in — rhythm,
scale, and chord rules. With /nstant Music you can concentrate on what sounds good, rather than "How do I voice a
C9 chord with an E bass?"

If you're an accomplished musician, you'll find that Instant Music is a powerful composing tool. It's a great place to
sketeh your ideas with the help of the built in artificial intelligence. You'll be thrilled at the speed with which you
can create different arrangements, quickly finding the one combination of voicing and instruments that captures the
essence of a song. You can save your ideas to revisit later, when you feel more like turning off the guides and fine
tuning your piece in “free mode" to add some unorthodox flair. And if you own a MIDI instrument, you can play
your finished song using /nstant Music's MIDI capability for excellent sound.

In short, Instant Music is a powerful tool, and it's fun to use at the same time. You'll create, hear, and see your
music instantly. The notes for each instrument are a different color, and the time each note plays is drawn as actual
length on the sereen, so you can easily see the relationships of instruments, rhythms, and pitches. If you're a
musician, looking at an entire 16 or 32-measure song in a single screen will give you a new awareness of music
structure, and a new way to analyze it. If you're a beginner, you'll be amazed at how much you can learn about
music, without studying — it's all play!

How To Use This Manual

This manual is organized so you can use just as much of it as you want. If you like to experiment (and we hope you
do), you'll probably want to know how to start the program, load a song, and jam. From there you can play with the
controls and discover the fun and power of Instant Music on your own. Butif you want some specific information,
the manual is designed to give you that, too.

The first chapter, Guided Tour, is an overview of the program that gets you up and running fast, demonstrating why
we call the program Instant Music. The second chapter, Going Further With Instant Music, is a series of lessons
that illustrate the program's more advanced features for those who want to create their own complex compositions.
The third chapter, Instant Music Reference, is a quick reference guide listing all of Instant Music's menus and
commands. The Appendix B at the end of the manual contains documentation for the music included with Instant
Music, and information for those who want 1o learn more about music theory and notation.
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CHAPTER 1: GUIDED TOUR

Starting Instant Music

To use Instant Music you'll need a Commodore 64 (or Commodore 128 in C64 modc), a monitor, a joystick or
mouse, one or two disk drives, and some initialized blank disks for saving your work. (Note: We recommend
that you use an audio/video cable that allows separate routing of audio to your stereo or other amplification
device. This will greatly improve the sound quality.)

Start your Commodore 64 as usual (start your C-128 in C-64 mode). Now, with Instant Music in the drive,
type Load "EA", 8, 1. After the program has finished loading, the title screen appears, followed shortly by the
Instant Music screen. The Instant Music theme song is loaded automatically and begins playing. (If you are
loading the program from the GEOS™ desktop, double-click on the EA Instant Music icon.)

Selecting Joystick or Mouse: When you start Instant Music, it is ready 1o be used with a joystick.
(Note: the joystick must be plugged into Port 2.) If you want to use a mousc as your input device, you need to
indicate this. Use your joystick to move the pointer to Option at the top right of the screen, press and hold the
joystick button, pull the pointer down to highlight Control, and relcase the button. A window appears for you
to select mouse or joystick control. Point to Mouse and click the joystick button. (If you don't have a
joystick, press Shift-C to bring up the Control window, and press Return to automatically select mouse
control.) Unplug your joystick, and plug the mouse into Port 2. Instant Music now recognizes your mouse as
the input device. We think you'll be especially pleased with the responsiveness of the program. Throughout
this manual, we will refer to "joystick." If you are using a mouse, pretend we said mouse, and use the left
mouse button when we say joystick button. (Note: if you're using a mouse, don't use the
keyboard shortcuts.)

Jamming: Before we start on our guided tour, let's take a quick detour and learn about joystick (or mouse)
jamming, a technique for turning your computer into a real-time musical instrument. Notice the button in the
upper-right comer of the screen that contains an icon in the shape of the joystick. This is the Jam Button.
The icon is white to indicate that jam is currently on. Now take a look at the instrument controls at the very
bottom of the screen. The instrument name in the control at the far left is highlighted in white; this means that
that instrument is currently selected for you to jam with. Move the joystick pointer so it's in the large center
window that contains the colored bars, hold down the joystick button, and start moving the joystick forward and
backward. (The pointer moves up and down on the screen.) You'll hear that the selected instrument is now
playing in response to your joystick movements. How's that for an example of instant music?

We'll discuss jamming in more detail in the jamming section later on. For right now, let's begin with some
other basics you'll need to know while working with /nstant Music.
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Screen Controls

You can operate /nstant Music through a number of different on screen controls. Figure 1.1 shows the Instant
Music screen with each of the controls labeled for easy reference. Most of these controls will be explained in
the next few pages. For now, click the White Button in the upper-right corner of the work screen to stop the
music. Also click the Jam Button; when you click the button, the joystick icon turns black, indicating that
the feature has been turned off.

Score Window

Scrol Arrow Help Line Flashing
| Tempo Bar l

r Scrtliill!

'DRAH |

Trock Control Rhythm Ruler Wolume Bar
Current Instrument Transpasition
Name Button

Figure 1.1: The Instant Music Screen

Loading Music

To load a song from the Instant Music disk, move the joystick pointer to File at the top of the screen; press and
hold the joystick button to pull down the File menu. Move the pointer down to highlight the Load option,
and release the button. A window appears (sec Fig 1.2) with a listing of the songs on the disk and a space for
entering the name of the song you want to load. Point to the song title //ey You and press the joystick button
(from now on, we'll call this point and press combination “clicking"), then click the Load button to load the
song.

The song is now loaded, complete with notes, instruments, volume and tempo settings, and pitch and rhythm
guides. (Pitch guides restrict the pitch of notes you can enter in a song to ensure that your song sounds "good."
Rhythm guides set the length of the notes you enter. You'll learn more about these guides in Chapter 2.)
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NOTE: Usec Load New in the File menu to load the blank template for a song. This loads every part of the
song except the notes — the instruments, the volume and tempo settings, and the pitch and rhythm guides.
You can then enter your own noles.

Now that you know how to load a song, you might want to experiment with the controls and menus. When
you're finished experimenting, or if you run into trouble, just come back to this point in the manual and reload
Hey You as explained above. The following few pages explain the features of Instant Music that you are likely
to use most often.

T RQH YOUR p9AY
FRI E& 515: FRERE JAcaues
JARATCAN g ROCK DL Eg
ROCKIH FtIPH? BARE Enﬁ
ARITRA ‘S BANCE Jnzz HALTZ

sont nAKE: ROCK DBLUES

|
St i1 10 R = B i 1 T

Figure 1.2: The Load Song Window

Playing Music

As soon as the song has finished loading from the disk (when the drive light has gone out), click on the red
Play/Stop button at the top right of the screen. Now the button changes back to white, and fley You begins
playing. You stop the music by clicking the Play/Stop button again. For now, let the song play.

The Instant Music Screen

Let's take a closer look at the Instant Music screen. What you see is a two-measure overview of the song in the
Score Window in the center of the screen, and a number of surrounding buttons and controls (see Fig 1.1)
The controls at the top of the screen let you work with the entire song — for example, to speed up the tempo.
The Seroll Bar (with left and right arrows) lets you scroll left or right through a song, one measure at a time.
We'll discuss the function of the other buttons, bars, and icons at the top of the screen as we go along,

The moving black line below the score window is the Scan Bar. It moves across the Rhythm Ruler to
show what portion of the music is currently playing. The Rhythm Ruler shows the pattern of the current
rhythm guide. (The pattern is visible only when three or fewer measures are displayed in the score window.)
Below the Rhythm Ruler are the controls for the three instruments playing in this picce (called Track
Controls). Each track control contains a Current Instrument Name, Transposition Buttons, a
Volume Bar, and a Hide/Display Button. The term track, as used in Instant Music, refers to a set of
notes (indicated by color) and the rhythm guides, pitch guides, and instrument assigned to that set of notes. Just
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as in music recording, you can manipulate the sound of each track scparately before combining them into a
finished song. When you copy notes from one track to another, you are actually copying more than just notes.
This will become clearer as you begin using the editing functions.

Changing Tempo

Move the joystick pointer up to the white horizontal Tempo Bar at the upper left corner of the screen. Press
and hold the joystick button, and drag the marker to the left to slow down the music. Drag to the right to speed
itup. (You can also simply point to the position you want and press the joystick button. The tempo bar will
adjust to meet the pointer.)

Changing Volume

You can control the volume of cach of the three instrumental voices using the Volume Bars in the track
controls below the score window. Click on the right side of the Volume Bar in the green track control (the
green horizontal bar) and drag it slowly to the left. As you do so, note that the volume of the instrument
decreases. As you move the Volume Bar back to the right, the instrument becomes louder.

Viewing Tracks

You can make the notes disappear entirely by clicking the Hide/Display Button to the right of the
Volume Bar. Click it again to make them reappear. This doesn't affect the sound of the piece, only the
appearance. Somelimes when there arc a lot of notes on the screen, you may want to look at the notes of just
one track. Switching off the notes of the other tracks is a quick way to get an overview of a single melody line.

If you write music with more than one instrument playing in the same octave range, notes may overlap. When
notes of two instruments occupy the same space in the score window, they appear in the color of the third
instrument (for example, red and green placed on top of each other appear as blue). Three notes placed on top of
each other appear as black. With the Hide/Display button, you can turn off the display of two instruments to
sce all the notes of the third. Or, you could write tracks in different octaves and transpose them as explained
below.

Transposing

With Instant Music, you can raise or lower a track's pitch (transpose) by an octave without changing the key.
Use the Transposition Buttons (the down-arrow, the square, and the up-arrow at the bottom left of each
track control.) When the middle square is lit, the track plays at its normal pitch. If you click the down-arrow,
the track plays an octave lower. If you click the up-arrow, the track plays an octave higher. Clicking different
Transposition Buttons does not, however, change the note display in the score window.

Changing Instruments

The Sounds menu contains the list of the instruments available. (Point 1o Sound and hold down the joystick
button to see your list.) If you want to use a different instrument in the green track, just click the name of the
green instrument in the control at the bottom of the screen. Now pull down the Sounds menu and sclect your
new instrument. Your new instrument is loaded as the green instrument, and its name appears on the green
track control.
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Entering Music

You can enter new noles, or change existing notes for any of the three instrument colors. First select the
instrument you want to work with by clicking its track control (select the red instrument for this exercise).
Now move the joystick pointer into the score window: notice that the flashing white cursor appears right next
to the joystick pointer. Use the joystick to move the flashing cursor around the window; at the same time,
click the joystick button in the score window a few times. If you click the joystick bution on a blank column
in the score, a new note is inserted at the flashing cursor position. If you click in a column that already
contains a note for your instrument, the note is raised or lowered to the flashing cursor position.

To erase an existing note, place the flashing cursor on the note and press Del on the keyboard.
The QuickDraw Etude in Chapter 2 shows another method of entering music.

Jamming

Instant Music offers you the unique opportunity to play your computer like a musical instrument. When you
select a track control and click the Jam Button (Figure 1.1), /nstant Music lets you use the joystick to control
the instrument assigned to the selected track. Thus, you can jam on a single track while the other two tracks
play backup. In addition to the Jam Button, there is also a Jam menu that provides three different types of
jam. (Note: Keyboard equivalents are offered 1o save you the time of pulling down menus to execute some of
the common commands. Here, for example, you could press P to select Preset Rhythm for jamming.
Shortcuts are listed beside the command in the Reference section.)

Score Rhythm: The Score Rhythm option keeps your jam within the musical boundaries established by the
song template. In essence, Instant Music looks over your shoulder as you jam and makes sure that you don't
play any off-key or out-of-time notes. Here's how to play a guided jam:

1. Click the Play/Stop Button to play the song if it's not already playing.

2. Click on the red track control to select it as the instrument you want to jam with.

3. It's a good idea to raise the volume of the jam instrument and lower the volume of the other
two. This makes your solos really stand out,

4. Pull down the Jam menu and sclect Score Rhythm.
5. Click the Jam Button at the top right of the screen (see Figure 1.1), and suddenly your
sclected track stops playing notes from the score. This is supposed to happen; Instant Music

has just turned control of the track's instrument over (o you,

6. Move the pointer down to the score window. The flashing cursor is now moving from left to
right in sync with the Scan Bar,
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7. Press the joystick button and your instrument begins playing again. When you release the
Jjoystick button, your instrument stops playing.

8. Now, while holding the button down, move the joystick forward and backward. Try moving it
slowly, then more quickly. The pitch rises when the flashing cursor is at the top of the screen
and falls when it's at the bottom,

9. Click the button scveral times as you move the joystick. Your jam instrument plays an
individual note cach time you click, in the song's rhythm.

As you can sce and hear, the instrument is now playing in response to your joystick movements, but the notes
are being kept in the proper key and rhythm.

Preset Rhythm: The Preset Rhythm option lets you use your computer's number keys to activate stored jam
rhythm styles. To get a feel for Preset Rhythm, select the Preset Rhythm option from the Jam menu, start
jamming, then push the 1 key along the top row of the keyboard. Now try 2, 3, 4, and so on until you've
gone through all the preset licks on the keyboard. Preset Rhythm lets you add another dimension of rhythmic
flexibility to your jams. Note: you must release the joystick button to activate a new preset rhythm.

Free Rhythm: The Free Rhythm mode operates exactly like Score Rhythm, except the song template rhythm
guides aren't used in the jam. While this gives you much more control over individual notes in the melodic
line, it also allows you to play notes when they really shouldn't be played. Other jam modes are better for more
structured improvisation because they use preset rhythms as guides.

Jam Experiments: With //ey You still loaded in the score window, try selecting the bass line (the blue track,
which uses a bass as the instrument) and jamming with that. Click the down arrow Transposition Button
to turn another track into a second bass line, and listen to the harmonies as you jam. What you're doing is like
jazz improvisation -- making up new notes "on the fly" to fit into a preexisting chord structure. Instant Music's
guides keep your notes within a preset pattern so no matter what you play, the notes fit. If you want to hear a
jam without pitch guides, select Set Guides from the Draw menu. Click the Free button in the upper half
of the window and click OK. Then try a jam. Now your creativity is completely unbridled, because the Free
Pitch Guide option removes the guides that keep the pitch of your notes within traditional musical
boundaries.

Keyboard Changes: In addition to using the keyboard to choose preset rhythms, you can use other keys to
make changes as you jam.

F7 Toggles jamming on and off
(0] Sclects Score Rhythm
p Selects Preset Rhythm

r Selects Free Rhythm
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1 Sclects the green instrument
F3 Selects the red instrument
F5§ Selects the blue instrument
Spacebar Starts and stops the music

T (Shift-cursor key) Raises the pitch for all tracks a half step.
Changes the sound, not the display.

L (cursor key) Lowers the pitch for all tracks a half step
if it was raised with the up arrow.

& (cursor key) Resets the pitch for all tracks to the
normal settings.

Finishing a Session
So far, you've been experimenting with existing music. In the next chapter, we'll discover how Instant Music
lets you write your own compositions, even if you know nothing about musical notation.

Saving Your Creations

If you want to save the music with the changes you've made, you can use one of these options in the File menu
—Save or Save As. (You will nced a formatted data disk on which to save your songs. If you don't have one
prepared, you can format one now without leaving the program: sclect Delete from the file menu, click Format
at the bottom of the window and follow the prompts. After the disk is formatted, No Songs On This Disk will
appear in the window and the pointer will reappear. Sclect Cancel to return to the /nstant Music screen.)

Save: Replaces the original song with your changed song, using the same title. Use this option if you have
made changes 1o a previously saved song and you want to keep the new version but not the original. Pull down
the File menu and select Save.

Save As: Lets you save your new song (or your modified old song) under a different title, while keeping the
old song under the original title. First pull down the File menu and select Save As. When the Save As
window appears, click in the song name field, type a new name for your piece, press Return, and click Save.
The picce will be saved under the new name. (If you want to save the file to a different disk, insert your disk
and click the Catalog button. Then enter the file name in the song name field, and click Save.) Or if you
change your mind and decide you want to go back to the Instant Music screen without saving, click Cancel.
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CHAPTER 2: GOING FURTHER WITH INSTANT MUSIC

This section is composed of nine etudes that cover the advanced features of /nstant Music in detail. An efude
(pronounced "ay-tood") is a simple lesson that introduces a specific technique or method. Each etude is made up
of a number of short exercises. The following etudes are self-contained and may be referred to individually if
you have questions about how to do a specific task in Instant Music. For instance, if you want 1o know how to
use /nstant Music's thythm guides, sce the Rhythm Guide Etude. You should have a formatted disk ready in
case you want to save your compositions. (The Delete option in the File menu also allows you to format disks
without exiting the program or song.)

I. Edit Commands Etude

This etude discusses how to copy, paste, and crase measures in your song. (The commands you'll need are found
in the Edit menu.) You'll learn how to change the length of your song and move notes, rhythm guides, and
pitch guides within a song.

Here is an overview of the commands you'll use:

Function Edit Commands

To copy one or more measures of a song, including Copy Color, Copy All Colors
notes and rhythm guides (and pitch guides with Copy All)

To erase one or more measures of notes (but not Erase Color, Erase All Colors
rhythm guides or pitch guides)

To paste a copy of notes and rhythm guides (and pitch Paste Color, Paste All Colors
guides with Paste All)

Exercise 1: Lengthening a Song. In this exercise you'll learn how to copy existing music and add
it to your song.

1. Load Rock8 from the Instant Music program disk. (Click on MORE SONGS at the bottom
of the right column to switch between pages in the directory.)

2. Sclect Song Length from the Option menu 1o add some blank measures to your song.
Click the up-arrow until Measures equals 4 and then click OK. Notice that four measures are
now displayed in the score window. The first two mcasures are the original Rock8 song, and
the next two measures are blank.

3. Click the Select Button above the score window. Position the joystick pointer in the first
measure of the score window, hold down the joystick button and drag the pointer toward the
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right to select the first two measures, then release the joystick button. A box surrounds the
two measures to indicale they are sclected.

4.  With the first two measures sclected, pull down the Edit menu and select Copy All
Colors. (This copies the notes, rhythm guides, and pitch guides from those two measures
into the copy buffer.)

5. Now click the Select Button, move the pointer into the third measure, hold down the
joystick button, and drag to select measures three and four.

6. Sclect Paste All Colors from the Edit menu. This tells Instant Music to paste the notes,
rhythm guides, and pitch guides into the score in the measures you selected. You have now
lengthened RockS8 to four measures without having to enter any notes by hand.

Exercise 2: Transferring Music Between Tracks. In this exercise you'll leamn how to move
music from one track to another.

1. Click the left-hand double-arrows in the Zoom Bar twice to zoom in and show only
measures 1 and 2 in the score window.

2. Now select the blue track by clicking its track control.

3. Sclect the entire score window with the Select Button and use Copy Color from the Edit
menu. (This copies the notes and rhythm guides from only the blue track into the copy
buffer.)

4, Click the Select Button and select the entire score window again. Erase the blue track
using Erase Color.

5. Select the green track.

6. Again, select the entire score window, but this time sclect Paste Color from the Edit menu.
The notes and rhythm guides from the copy buffer (which had previously belonged to the blue
voice) have now been transferred to the green voice. Note that we didn't have to crase the green
voice; we simply pasted over it.

II. Rhythm Guides Etude

This etude explains the concept of rhythm guides and shows you how to use them in writing your own music.
The exercises in this etude also point out the difference between the standard rhythm guide (called Guided) and
the custom rhythm guides available from the Draw menu (such as Quarter and Eighth).
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Exercise 1: Using Standard Rhythm Guides. In this exercise, you'll learn how to copy the
standard rhythm guides for a song, view these guides for each track, and use them to create your own song.

1. Load Rockin’ Flight and play il.

2. Sclect all the notes and crase them using Erase All Colors from the Edit menu. (The
noles of your song are now erased, but the thythm guides and the pitch guides for that song are
left unchanged. Each track has it§ own rhythm guide.)

3. Narrow the score window to three measures with the Zoom Bar. (Now you can see the
rhythm guides in the Rhythm Ruler below the score window.)

4. Pull down the Draw menu and select Set Guides. This displays the Set Guide window (see
Figure 2.1). In the Rhythm Guide arca of the window, make sure that the Guided button
is selected (highlighted in yellow). Then click OK. (This tells /nstant Music to keep the
standard rhythm guides for the song.)

SET GUIDES ]

HELOD SCALE .
— tch Guides
|| [[CHORD ] [__EREE |

SIXTEENTH x\hyh allie
1 1hm Guides

E | ITRIPLET |
| oK ” cAanceL |

Figure 2.1: The Set Guide Window

5. Now select the three tracks, one by one; look at the Rhythm Ruler (below the score
window) for each track. Notice that the black bars in the Rhythm Ruler vary in length to
reflect the rhythm guide pattern for that track. A track's rhythm guide determines the length of
the notes to be inserted in that track.

6. Select a track that has a great deal of rhythmic activity (black bars of varied lengths), and enter
some notes. Notice that the lengths of these notes correspond to the lengths of the rhythm
guide bars in the Rhythm Ruler.

Exercise 2: Using Custom Rhythm Guides. In this exercise, you'll see how to change the
rhythm guides for any of the instruments to the custom rhythm guides that can be accessed through the Draw
menu.
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1. Pull down the Draw menu. Select Set Guides, and in the Rhythm Guide area, click
Quarter. Make sure that Discrete is sclected (if it's not, click it.) Click OK. Now any
notes you add to the score will automatically be quarter (1/4) notes. (Notice that a grid of
dotted vertical lines now appears on the score. These are to help you judge the comparative
length of notes, especially ‘when you change rhythm guides several times and add notes of
several different lengths.)

2. Select a track and enter some notes. Notice that the corresponding black bar on the Rhythm
Ruler changes to reflect the length of each note you add to the score.

3. Try other rhythms such as Eighth, Eighth and Triplet, and Sixteenth; and enter some
notes in the score while in each of these guides. (Note:. Triplet can be selected with any of the
custom rhythm guides. When Triplet is sclected, the notes entered will be 2/3 the duration
indicated by the custom guide.) While in cach of these guides, hold down the joystick button
and slowly move the cursor across the screen. This is an easy way to enter 2 number of notes
in one gesture.

4. Go back to the Draw menu and choose Set Guides. In the Rhythm Guide area, click
Eighth and Multiple. Click OK.

5.  Enter notes on the screen by holding down the joystick button and slowly dragging the pointer
a short way before releasing the button. Notice that when using 1/8 and Multiple, notes are
entered in lengths that are multiples of 1/8; i.e., 1/8, 1/4, and so on.

NOTE: If you are familiar with musical notation, you can write rhythms and enter drum patterns or melodies
using custom rhythms. If you are truly ambitious, try taping one of your favorite drum patterns, then transcribe
it into Instant Music.

III. Bass Line Etude

In this etude you'll use the Chord Pitch Guide and the Scale Ruler to write a simple bass line.

1. Load 1962 Fun. Listen carcfully to the bass line (Track 3). Tumn down the other instruments
if you like.

2. Pull down the Draw menu and use the Scale Ruler command if the scale ruler isn't already
displayed. Then, set the Pitch Guide to Chord. The chord pitch guide insurcs that all
notes you enter are valid notes that belong in the chord.

3. Place the joystick pointer in the first measure and move it up and down. This causes two
other changes on the screen: 1) A white arrow moves up and down the scale ruler on the right
side of the score window, and 2) the note indicator below the keyboard on the left side of the
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screen displays the letiers of the notes in the scale. Move the joystick pointer until the white
arrow is aligned with a white tick mark, which represents the root note of the chord. The note
indicator shows that the root note is G.

You can use this method to determine the other three noles in this chord, which are B and D.
Select the bass voice (Track 3) and choose Erase Color from the Edit menu.

To compose a new bass line, usc the Zoom Bar to narrow the score window to display only
two measures. The two measures of bass line that you build can later be copied and pasted to
the rest of the song.

Set the Rhythm Guide to Quarter. Look at how the two measures are now divided in the
score window. The solid vertical line down the center of the window indicates the measure
division, and the dotted vertical lines indicate where the beats within the measures fall. You're
using 1/4 rhythm, which means there are four beats per measure, thus each measure in the
score window is divided by three vertical dotted lines,

Move the joystick pointer in the first measure until the white arrow on the Scale Ruler is
pointing at the sccond from botiom white tick mark and the Note Indicator says G. Click
in the first and third beats of the first measure to insert the note G, Because each of these
notes is only a 1/4 beat in length, they are called quarter notes. (Note: To erase any mistakes,
place the cursor on the incorrect note and press Del on the keyboard.)

In the second measure, enter a B quarter note (the short red tick mark on the scale ruler) on the
first and fourth beats in the second lowest octave.

Zoom out to display all eight measures of the song, and Copy Color the two measures
you've entered.

Now select measures 3 & 4 of the song and use Paste Color. Repeat this process with
measures 5 & 6 and 7 & 8 so that the first two measures arc duplicated throughout the rest of
the song. Listen to the song. The result is a very plain bass line, so let's add a bit of variety
by modifying each measure of the bass line.

Zoom back in to two measures and lower the second B note in the second measure by a full
octave.

Now Zoom out 1o display the entire song and copy the first two measures with Copy
Color.
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14, Use Paste Color to duplicate your two measures throughout the rest of the song. Now
listen to the song again. You should be able to tell quite a difference from the previous bass
line.

This ctude has shown how to display the Chord Pitch Guide, how to write a simple bass line, and how to
add variety and substance to the bass line just by rearranging notes within the chord. In the next etude, we'll see
how to build an actual chord.

IV. Chords Etude

This etude demonstrates how to use Instant Music's polyphonic chord utility. The word polyphonic simply
refers to Instant Music's ability to sound multiple notes at the same time from a single instrument — an ability
that is essential for playing chords. (/nstant Music on the Commodore 64 can sound 3 notes at the same time
for one instrument. Because the C-64 can play only three notes, if there are more than three written to play
simultaneously, any chords played by one instrument will be stripped down. For example, if one instrument
plays a three note chord while another instrument plays a single note, the three note chord will actually play as a
two note chord.)

1. Load BarnDance.
2. Scleet the blue track and Erase Color.

3. Set the Pitch Guide to Chord and the Rhythm Guide to Quarter. (Also from the
Draw menu select Scale Ruler if not already sclected.)

4. Zoom in to display only four measures and begin entering quarter notes on the first and third
beats in these measures. Enter notes on the root of the chord (the white tick mark). Enter the
lowest possible root note because the notes on beats one and three will form the bass line.

5. You have just entered all the oom’s, but you still need to enter the pah’s. Click on the two
black dots of the Chord Control (above the score window and to the right of the Select
Button) so you can enter 2-note chords.

6. Now enter chords at mid-screen level on the second and fourth beats in the selected measures.
Every time you click the joystick button, two notes are entered. These two noles together form
the chord. Chords are built down from cursor position, so your cursor always points at the top
note of the chord.

7. When you have entered chords in all four measures, play the picce and listen carefully.

8. Experiment by changing all the 2-note chords to 1-note chords (by clicking the single dot on
the Chord Control), and listen to the difference.

13
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In this etude you have performed an example of entering chords as an accompaniment to a melody. Generally, a
good strategy is to put chords on the weak beats (2 and 4 in 4/4 rhythm; 2 and 3 in 3/4 rhythm), and single
bass notes on the strong beats (1 and 3 in 4/4 rhythm; 1 in 3/4 thythm). Experiment with using 1, 2, or
3-note chords until you find the sound you like.

V. Pitch Guides Etude

This etude is a continuation of the previous etude (IV. Chords Etude). If you haven't done the chords etude yet,
do it before continuing with this one.

The following exercises demonstrate how to incorporate the Melody, Scale, and Free pitch guides in the
melody line of your composition. Pitch Guides arc one of /nstant Music's most powerful tools because they
restrict the pitch of notes you can enter in a song to ensure that your song sounds "good.” Each pitch guide
restricts you in a different way. The fewer restrictions you have (for example, with the Free pitch guide), the
more opportunity you have to create strange sounds, and the more careful you must be when entering notes.

Exercise 1: Using the Melody Pitch Guide.

1. Zoom in to display measures 1 and 2 only.

2. From the Draw menu, select Set Guides. Sclect the Melody pitch guide and Guided
rhythm. Click OK. Select the green track and note the rhythm guide pattern for the green
track on the Rhythm Ruler.

3. Enter notes for the green track at the top of the score window. You'll notice that the scale
ruler changes as you enter notes. The scale ruler changes on cach beat 1o reflect the boundaries
set by the Melody pitch guide.

4. When you have entered a simple melody, play it to see how you did, save it if you want, then
erase it

Exercise 2: Using the Scale Pitch Guide. In this excrcise, you'll see how to use the Scale
Pitch Guide and how it affects your music.

1. Set the Pitch Guide to Scale.
2. Enter a new melody at the top of the score window. Notice that there are many more notes

indicated on the scale ruler now, giving you a great deal more freedom in where you can enter
notes in the score.
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3. Once again, play your melody. If you notice that your new melody doesn't sound quite as
good as the last (this, of course, will depend upon your musical knowledge) it's because Instant
Music didn't give you as much help when placing your notes this time around. Erase your
melody again.

Exercise 3: Using the Free Pitch Guide. In this exercise, you'll see how to use the Free Pitch
Guide and how it affects your music.

1. Set the Pitch Guide 1o Iree.

2. Now enter another new melody and listen to it. With a Free Pitch Guide the sound of your
music depends entirely on your musical abilitics — Free Pitch Guide gives you absolute
freedom in the way you enter noles.

The last two etudes have covered all four of the Pitch Guides. The Pitch Guide you use most when
creating your music will depend on your knowledge of music. Novices should always use Melody and Chord.
Intermediate musicians should use any of the first three Pitch Guides and experiment with Free. Experienced
musicians can use whichever Pitch Guide is appropriate for the musical project.

VI. QuickDraw Etude

This etude introduces another powerful tool of Instant Music: QuickDraw.

Exercise 1: Using QuickDraw. In this exercise, you'll see how to use the QuickDraw function to
quickly enter large numbers of notes into your composition.

1. Use Load New to load BoogieWoogie.
2. Zoom in to display only lwo measures.

3. Set the Pitch Guide to Scale and the Rhythm Guide to Guided. QuickDraw can
only be used with the Guided Rhythm Guide.

4. Click the QuickDraw Button above the score window. (The lightning bolt turns white
when selected.)

5. Position the cursor on the left side of the score window, hold down the joystick button, and
drag the cursor straight across to the right side. As you drag you'll notice that a line stretches
from the point where you initially pressed the joystick button.
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6. Releasc the joystick button on the right side of the score window and watch Instant Music fill
in notes along the path created by the line. This is QuickDraw. Listen to your new creation
and then erase it.

Exercise 3: Using QuickDraw Patterns. In this exercise, you'll learn how to QuickDraw in
different patterns that create interesting lines of music.

1. Select QuickDraw Pattern from the Draw menu and select the pattern in the lower right
corner. Click OK. Notes entered with QuickDraw will now be entered in the pattern
represented by the three dots you selected.

2. Once again drag a line from the left side of the score window to the right. Though the line
itself is still straight as you drag across the score window, notes are entered in a wavy pattern
as ybu release the joystick button.

3. Play your new QuickDraw creation and listen to the difference with this new pattern.
4. Experiment with the other QuickDraw patterns.

In this etude you've scen how to use QuickDraw. You can add even more varicty to your music by using
different Pitch Guides with the QuickDraw patiemns. For instance, try using QuickDraw with 3-note
chords (see IV. Chords Etude). Vary the pattern often when you use QuickDraw. An interesting effect is to
enter the tremolo pattern (lower left and top right patterns) in one track and the triplet pattern (lower right) in
another track.

VII. Progressions Etude
This ctude shows how to use progressions from the songs provided with Instant Music in your own
compositions. A progression is a song scgment used over and over in various places throughout a composition
— like a repeating chorus.

1. Load RockS5.

2. Sclect the entire score window with the Select Button and then use Copy All Colors.

3. Now Load Rockl2.

4. Pull down the Option menu and change Song Length to 8 measures.

5. Paste All Colors into measures 5 & 6, then repeat for measures 7 & 8. Measures §
through 8 of Rockl2 arc now the RockS progression repeated twice.
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6. Use Copy All Colors to copy measures 1 & 2, then Paste All Colors into measures 3
& 4.

7. Now play the song and listen carcfully. Although the mood and texture of the two
progressions we combined are fairly different, all the chord and scale guides necessary to make
an original song arc there.

In this etude you've seen how to take a progression from one song and use it in another. You can copy and
paste a single color or all colors between songs. Try making a collage with measures from your favorite
arrangements.

VIII. Polyrhythm Etude

In this etude you'll examine two examples of polyrhythm with Instant Music. Polyrhythm refers to two or
more different rhythms going at once. Polyrhythmic music is often difficult to perform, but by using different
rhythm guides simultancously in /nstant Music polyrhythmic music becomes quite simple.

1. Load Samba and listen to it carefully.

2. Tumn the volume for the blue track all the way down and put the red track at full volume. Now
listen carefully to the main rhythm (4 beats per measure) with just the red and green tracks

playing
3.  Zoom in on the first measure and you'll notice that there are four notes for each of the four
beats in the red track. These are called 16th notes because with 4 notes for each quarter beat

there are a total of 16 notes in a measure.

4. Now we'll slightly modify the rhythm. From the Draw menu, select Set Guides. Sclect
Eighth and Triplet from the Rhythm Guide. Click OK.

5.  Select the green track and enter notes over the existing melody. The result should be 12 green
noltes in the measure.

6. Listen to the result at various tempos and turn up the volume for the blue track. You are
hearing 4 beats against 3 beats.

7. Repeat step S for the rest of the song and listen to the result.
8. Set the Rhythm Guide to Quarter and Triplet.

9. Enter a new melody in the green track for the entire song.
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10. Now listen to your polyrhythmic picce. The result is heard as a 2 beat against a 3 beat
rhythm.

Used cleverly, polyrhythms can add a new level of interest to your music. However, be careful not to obscure
the main beat with a thythm that's too clutiered.

If you've worked through all eight etudes, you're well on the way to becoming a seasoned musician. But don't
stop here. Listen to the songs on the program disk and experiment with the features of /nstant Music.
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CHAPTER 3: INSTANT MUSIC REFERENCE

I. Screen Controls

Refer to Figure 1.1 for the location of these controls. The keyboard cquivalents (where they exist) are listed in
parentheses after the feature name. A summary of all keyboard shortculs appears as Appendix C. Note: Do not
use keyboard shortcuts while holding down the joystick bulton.

Tempo Bar — Used to change the speed of the picce. Moving the tempo bar to the right plays the music faster,
moving to the left plays slower. You may also change the tempo while a song is playing — this often results in
surprising changes in mood. The tempo selling is saved with each song.

Zoom Bar — Lets you zoom in to view a single measure, or out to view an entire song (up to the maximum
allowable length of 32 measures). Every song has a defined maximum length (sce Option Menu  below), and the
Zoom Bar allows you to zoom out to the song's defined maximum length. Click the left double-arrow to zoom in,
the right double-arrow to zoom out. To view an entire song, make sure the first measure is the leftmost measure.

Select Button — Used to choosc notes to be copicd, pasted, or erased. Defaults to full screen. To select a
portion of the screen, press and hold the joystick button at the left edge of the desired section, "drag" the area
(move the joystick with the button held down) and release the button. Selections are restricted to measure
boundaries.

Chord Control — For sclecting whether chords will be entered one, two, or three notes at a time. Position the
cursor at the note you want lo be the top note of the chord. [nstant Music then automatically adds the next one or
two notes (when in 2-note or 3-note modes) below the top note according to the current chord. For example, if
the chord is C7 and you arc in the three-note mode, a top note of Bb will result in an E-G-Bb chord. Likewise, a
top note of F# in a D7 chord will result in a C-D-I'# chord.

QuickDraw Button (Lightning Bolt icon or Q on the keyboard) — Draws with one of the four selected patterns
available in the Draw menu (sce below). (The patterns can also be selected using the Z, X, C, and 'V keys.) The
top left pattern will result in a relatively lincar pattern, depending, of course, upon melody, chord, or scale mode.
The lower left and upper right patterns draw noles in a tremolo pattern, and the lower right pattern draws notes in
triplets, All in all, QuickDraw is very useful for cntering a large number of notes with a single broad gesture.
Experimentation with QuickDraw is heartily recommended. Using Free Pitch Guide with the QuickDraw function
produces a smooth line of notes; other pitch guides can produce wavy lines of notes.

Jam Button (Joystick icon or F7 on the keyboard) — Allows improvisation with selected track instrument.
Uses Jam menu options (sce below).

Play/Stop Button (White or Red button) — Starts and stops the music. Pressing the Spacebar on the
keyboard is the equivalent of clicking on this button.

Scroll Box and Arrows — Clicking the right arrow scrolls 1 measure to the right of the score window (up to
the current song length). Click the left arrow to scroll 1 measure to the left of the score window (down to the first
measure). Clicking and dragging the scroll box moves you quickly to any measure or group of measures.

19
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Track Controls (F1, F3, or F'5 1o sclect tracks 1, 2, or 3) — The track controls give you complete control
over the three instrumental voices that are used in your music. Each track control contains the following gadgets:

Hide/Display

Button: This is a round button on the right side of the track control which allows you to
hide or display the notes for a particular track. This button doesn't affect sound,
only appearance.

Volume Bar: This is a horizontal bar in the center of the track control that displays the color

and controls the volume level of a particular track. Decrease and increase volume
for a track by dragging the Volume Bar to the left or right.

Transposition

Buttons: These three buttons are located to the left of the Volume Bar on the track control.
They lower or raisc the oclave of the selected track without changing the key.
Click the down-arrow at the far left to lower the octave, the up-arrow at the far
right to raise the octave, and the square in the center to put the track back at its
normal octave. When used in the lower range of the score window, some
instruments sound better when raised an octave with the Transposition Buttons.

To Enter Single Notes — Move the flashing cursor to the desired location and click the joystick button,
When entering notes with guided rhythm, the time value for a given note is automatically assigned according to
the thythm guide. When in multiple mode and rhythm is not guided, you can click and drag the notes horizontally
to the right for longer durations up to a whole note.

To Erase Single Notes — Move the flashing cursor to the note and press the Del key on the keyboard. (If
you arc using a mousc, you can ecrase notes by moving the cursor to the note and pressing the right mouse
button.)

II. Menus and Commands

File Menu — Use for all of Instant Music's disk and file commands. These commands all bring up a window for
selecting or entering song titles. Whenever the window is opened, the Song Name box shows the name of the
current song if there is one loaded.

Load (L): Brings up the Load window so you can load complete songs from disk, including
noltes, instruments, volume and tempo settings, and pitch and rhythm guides.
Click "More Songs” to switch between pages in the directory.

Load New: Lets you load a song template — no notes are loaded, but instruments, volume
and tempo scttings, and pitch and rhythm guides remain in place.

Save: Saves the loaded file to disk under the current file name — replaces any file with
the same name.
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Save As (S):

Delete:

Brings up the Save As window so you can save the loaded file to disk under a
new name — leaves original file (if any) unchanged. See Saving Your Creations
for more information.

Brings up the Delete window so you can delete songs from your disks. This
window also enables you to format disks without leaving the program. (To format
a disk: seleet Delete from the file menu, click Format at the bottom of the
window and follow the prompts. Afier the disk is formatted, No Songs On This
Disk will appear in the window and the pointer will reappear. Select Cancel to
return to the Instant Music screen.)

Draw Menu — Used to select the guides for entering notes and rhythms, and also for selecting QuickDraw
patterns and using the Scale Ruler.

Set Guides (G):

QuickDraw
Patterns
(£,X,C,V):

Brings up the Sct Guides window for sclecting pitch guides and rhythm guides.

The Pitch Guide arca selects the pitch guides for all tracks.

Melody — use a preset melody scale (the most restrictive)

Chord — use only the notes of the current preset chord

Scale — use only the notes of the currently-defined scale (seven notes)
Free — no pitch guides operating; full chromatic scale (12 notes)

The Rhythm Guide arca sclects the rhythmic pattern for the song.

Guided — uses the preset thythm pattern, The rhythm guide pattern is shown in
the Rhythm Ruler below the score windotw only when 1, 2, or 3 measures arc
displayed.

Quarter, Eighth, and Sixtcenth — the checked rhythm operates on all new notes
entered into the note screen. Triplet can be selected with any of the custom
rhythm guides, for example Quarter and Triplet. When Triplet is selected the note
will be 2/3 the duration indicated by the custom guide. The rhythm guides
determine how many beats are allowed per measure, and the length of the notes
you enter.

Multiple/Discrete — 1f multiple is selected, notes of any length that arc
multiples of the sclected custom rhythm are allowed; i.e., a multiple of 1/4, 1/4
triplet, and so on. If diserete is sclected, notes of only one length are allowed.

Sclects a pattern with which you can lay down a preset pattern of notes.

Sclect one of the four patterns. Then click the QuickDraw button on and draw a
line in the scorc window by pressing the joystick button, dragging the cursor,
and releasing the joystick button.
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Scale

Pitch

Ruler (R):

Guide:

Rhythm Guide:

Brings up a sct of markers on the right side of the screen. Not operational in
Free mode.

White marker line — the root note (unison)

Long red marker line — dominant note (fifth)

Short red marker line — third (mediant) or seventh

Blue marker line — second, subdominant (fourth), and sixth

The Scale Ruler command also brings up the following on the left side of the
work screen:

Keyboard: A mini-piano, with a onc-octave range, showing the keyboard
equivalent of the note under the flashing cursor.

Note: Shows the lctter name of the note currently under the flashing cursor.
Both "enharmonic" names are provided for sharp and flat notes (for example, F# /
Gb).

Number: Shows the position of the note relative to the root of the chord you
are playing in. There is no number in Free mode.

M if set to Melody; S if sct to Scale; C if set to Chord. There is no Pitch Guide
indicator if you arc using Free mode.

Indicates which rhythmic mode you are in. G if set to Guided; 4 if sct to Quarter;
8 if set to eighth; 16 if sct to sixteenth; a T follows the number if Triplet is
selected,

Edit Menu — For copying, pasting, and crasing notes; used with Select Button above the score window. If
Sclect is not used, Edit applics to the whole screen.

Erase Color:

Erase All
Colors:

Copy
Copy
Paste

Paste

Color:

All Colors:

Color:

All Colors:

Erases notes (but not rhythm guides or pitch guides) for the current track in the
selected portion of the score window.

Erases all notes (but not rhythm guides or pilch guides) in the selected portion of
the score window,

Copies the selected notes and rhythm guides.

Copies the selected notes, rhythm guides, and pitch guides for all three tracks.
Inserts copied notes and rhythm guides from a single track.

Same as Paste Color, but for all three tracks.
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You can also use the copy buffer like a clipboard, enabling the insertion of a part of one song into another song.
Simply copy the section of a song you want to move. Load the song that you want to paste the section into,
then paste the section where desired. Check the song documentation in Appendix B to make sure that the time
signature is the same for both songs, or notes may be lost or added. If a time signature isn't listed for a song in
the Appendix B documentation, then assume that the time signature for that song is 4/4.

Sounds Menu — For loading different instruments into [nstant Music. To assign an instrument to a track,
select that track, pull down the Sounds Menu, and select the instrument you want,

Jam Menu — for using the joystick as a real-time musical instrument

Score Rhythm (O): Jam notes are kept within the pitch and rhythm pattern of the currently selected
track.

Preset Rhythm (P): Calls up one of nine preset jam rhythms by pressing a keyboard number.

Free Rhythm (I): Plays unguided notes using the selected instrument with each click of the joystick
button.

When the scale ruler is displayed, Jam response may be affected.  Close the scale ruler if this is the case.
Option Menu — Use this menu to set song lengths and perform other special functions.
Song Length: Brings up a window where you can specily how many measures in length a song
will be. Instant Music allows songs up to 32 measures long. Click the up-arrow
to increase the number of measures, or click the down-arrow to decreasc the

number of measures in a song,.

Synthesizer (Y): Brings up a window where you can customize the sound of instruments. For a full
explanation of the synthesizer controls, sce Appendix A.

MIDI (M): Brings up a window for assigning MIDI (Musical Instrument Digital Interface)
output settings. For a full explanation of the MIDI controls, sce Appendix A.

Measures: Turns the measure lines in the Score Window on and off.

Control: Usced to select the type of input device used (joystick or mouse).

Quit: Exits the program and returns to Basic.
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III. Default Guides

Even before you load a song into Instant Music, there are guides at work in the score window. The default scale
guides are all "chromatic,” i.c., no guides. This information is important if you decide to increase the number of
measures in an already loaded song. Though the right side of the screen is blank, these default guides are there —
but invisible. Pasting a section of a song with guides into this arca overwrites the default guides. The default
rhythm guides are all whole note guides that serve as "place keepers” until you modify the rhythm.

Glossary of Music Terminology
Atonal: Lacking a traditional key or tonality.

Chord: A group of two or more notes played at the same time. Usually, chords consist of a pattern of
successive altered or unaltered thirds (e.g. C7 = C-E-G-Bb; Ddim = D-IF-Ab-Cb).

Counterpoint:  The interplay between two or more melodies. This often consists of a pattern of consonances
("sweet” sounding intervals) and dissonances ("harsh” sounding intervals), as well as implied chords.

Diatonic Mode: An cight-note scale that may begin at any note in a major scale. When playing just the
white keys on a keyboard instrument, the octave (cight notes) beginning with C is known as the lonian mode. It
is identical to the major scale. The octave beginning on D is the Dorian mode. Other modes include the Phrygian
(E), Lydian (), Mixolydian (G), Acolian (A), and Locrian (B). Greensleeves was written in the Dorian mode. Jazz
masters such as Charlie Parker, John Coltrane, and Cecil Taylor have exploited the possibilities of these modes in
dizzying variety.

Harmonic Voicing: When arranging a song, you may write a chord in many different ways. For instance, if
you are laying C major chords down, you could put C (the root) on top (E-G-C), in the middle (G-C-E), or on the
bottom of the chord (C-E-G). Each "voicing" has a subtle distinction within the context of a particular measure in

a particular song.

Interval: The relative spacing between two notes. For instance, the interval between C and D is a second. The
interval between C and I is a third, etc.

Jam: To improvise musically with other parts or instruments.

Key: The tonal "center”" of a song; also, the tonic note (first note) of a specific scale.

Meclody: A group of notes played sequentially (as a tune).

MIDI: Stands for Musical Instrument Digital Interface. A standard that describes music as a series of numbers,

and defines standard connections. All electronic musical instruments (like synthesizers and drum machines) that
use MIDI can be hooked together.
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Octave: The most consonant interval; the eighth tone in a major or minor scale. The interval is so consonant,
that cach note sounds like a duplication of the other,

Polyrhythm: Multiple rhythms. This term generally refers to two or more different rthythms going on at the
same lime, such as 1/8 twriplets and 1/16 notes.

Progression: A succession of chords or harmonies. For example, a standard 12-bar blues progression is:

C71/CiiC1/CT
F1/F1/C1}CT
G7/F1/CT/CT

Range: For a particular instrument, it is the span [rom the lowest note that can be played (well) to the highest
note. The range for most instruments in Instant Music is 4-1/2 octaves; this entire range can be moved up or
down an octave with the transposition buttons on the track controls.

Register:  An area within an instrument's range. The color of an instrument often varies from register to
register. [or example, a melody played on the vibes in the low register has a much different effect from the same
meclody played in a higher register.

Rhythm: Technically, it is the temporal pattern in which musical beats or events occur. It might also be
considered as a "melody" independent of pitch.

Scale: An ordered pattern of notes, usuvally notated in ascending or descending order. Diatonic scales, such as
major and minor, consist of eight notes (including the octave). These are the most commonly used scales. The
chromatic scale consists of 12 consecutive half tones (the smallest interval in Western music); the whole tone
scale consists of 6 consecutive whole tones (e.g.: the interval from C to D or F# to G#). Other scales include the
blues scale (C-DH-E-F#-G-A-Bb-C) and the diminished or octatonic scale (C-D-Eb-F-F#-G#-A-B-C).

Synthesizer:  An electronic device used to produce sounds unobtainable from ordinary musical instruments.

Transposition: Changing the key of a picce by raising it or lowering it a constant interval. In [nstant Music,
instrument transposition is done up or down one octave; thus, the key is not changed.

25
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APPENDIX A: SYNTHESIZER AND MIDI CONTROLS

Synthesizer Controls

You can use the synthesizer to build custom instruments to suit the mood of your music. With it you can create a
wide variety of original sounds. To use the synthesizer, seleet it from the Option menu (or press Y on the
keyboard) and click Load in the window. The synthesizer will operate on the currently selected instrument in the
Instant Music screen. The pointer still operates on the screen controls, but will not open menus, so you can
select any of the three instruments in the current song by clicking on that track control, but you can't assign a
different instrument from the Sounds menu,

The Synthesizer can be used with the music playing, so you can hear how the instrument will sound as it plays a
particular piece. Or, to build an instrument for a particular octave range, you might draw scales of notes in the
desired range using QuickDraw and then build the instrument while the scales are playing. It is especially helpful
to hear how the instruments sound playing different octaves and notes of different duration.

When you save the song, your newly created instruments arc saved with it and will load when the song is loaded.
The instruments cannot be saved by themselves, but by checking your settings with the Number level indicator
(described below), you can easily set up the same instrument in another song.

Waveforms — There are four waveforms to choose [rom across the top of the synthesizer. The waveform in red
is the currently sclected waveform. To seleet a wavelorm, point to it and click the mouse button.

Triangle Wave: This waveform is common to flute, piano, and guitar. A reduced volume is
characteristic of this waveform.

Sawtooth Wave: Common to brass and strings.

Pulse Wave: This is a special effect produced by synthesizer instruments and is capable of
producing the widest range of instrument sounds, It is basically a wave in two parts.

Noise: A random sound pattern (white noise) uscful for percussive effects.

ENV (Envelope Generator) — Used to sct the time required for the note to attack and release. To change the
setling, point to the lever, press the joyslick bulton, move the pointer up or down as desired, and release the
joystick button.

A: Sets the attack time — the rate at which the volume rises from zero volume to full volume.

R: Sets the release time — the rate at which the volume falls from full volume to zero volume.
Freq (Frequency Modulator) — used to set the rate and depth of the modulation of pitch — the raising and
lowering of the pitch in a "vibrato” manncr. Modulation is a particularly important characteristic of string and

brass sounds.
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R: Scts the rate of the modulation — how rapidly the pitch rises and falls to create modulation.
D: Scts the amount of modulation — the degree to which the pitch rises and falls from the central

pitch.

Pulse — Used to sect the rate, depth, and value of the pulse (applies only to a pulse wave)
R: Sets the rate of the pulse modulation
D: Sets the depth of the pulse in the wave
V: Sets the ratio between the two halves of the pulse wave

Instrument Name — Used to name your customized instrument. You should name the instrument something
different from the instruments that appear in the Sounds menu to avoid confusion later.

Test Button — Emits a single tone so you can hear the instrument's settings in isolation instead of as part of a
song. Point to the test button and click the joystick button to sound the test tone.

Number level indicator — Displays a number value for the lever most recently used. To sce the number value
for any particular lever, simply place the pointer on the lever and click the joystick button. The number indicator
will be updated to show the number value for the setting of that lever. Since you can't transfer custom instruments
between songs, when you create an instrument you especially like, you should write down the settings to be used
clsewhere.  Once you get the hang of it, setting an instrument will take just a few seconds.

SYNTHESIZER
2N o =Y ~t
EnV FREQ PULSE

Ll

R D R DU

[E=aE

cAanceL

Figure A.1 The Instant Music Synthesizer

MIDI Controls

The MIDI capabilities of Instant Music let you hear your compositions in very high quality sound. If you own a
MIDI instrument, we highly recommend that you hook it up to your Commodore to use [nstant Music. The results
are well worth the cost of the interface. (Note: The MIDI output of M has becn tested with Passport and Dr. T's
MIDI interfaces. If your MIDI sctup does not work at we describe, check the interface in addition to consulting
you MIDI instrument's manual.)

A2
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Track Assignments (1, 2, 3) — these work much like the track controls. The highlighted track number is the
track to which the Channel and Preset values apply (1 is the green track, 2 red, and 3 blue). Click the button to
activate a track, then assign the appropriate Channel and Presct values as explained below.

Channel — Used to set the channel on which the output signal will be transmitted. There are sixteen channels.
Click the box to select it and use the arrows to change the value.

Instant Music will transmit the music on separate channels, but you must set your MIDI instrument to play three
separate voices (multi-timbral mode), or all of the notes will be played by one voice. On the Casio CZ101, this
is done by pressing the key labeled MIDI and then pressing the key labeled Solo. You are now ready to set your
MIDI instrument to play a different voice on each channel. Sce your Casio manual for details.

Preset (number) — Used to set the Preset to be used when playing the track. There are 128 presets. Consult
your MIDI instrument documentation for information about particular presets, since the preset value assigned to
any particular voice varies among MIDI instrument brands. It will help if you become familiar with how your
MIDI instrument handles prescts. The Preset for cach track has been set to the value appropriate for a Casio
CZ101. If you want to change a Presct value, sclect the track you want to change, click the box beside Preset to
select it, and click the arrows to change the value.

Note: If the song you are playing contains short notes and the instrument you select on your MIDI device has a
long attack time, you may not hear the full note played.  You can work around this cither by assigning an
instrument with a faster altack time, or by slowing down the tempo of the song.

Presets (button) — Activates the Preset numbers to be sent along with the other MIDI information. This button
always defaults to "selected” (highlighted yellow), and the Preset numbers are sent.  When Prescts is not selected,
no preset number is sent by /nstant Music, and the MIDI instrument will play whatever instrument is assigned to
the channel on which the music is sent. Thus, you can change the instrument assigned to a channel while the
music is playing. Click Presets to deselect it (highlighted gray).

Clear — Returns both Channel and Preset scttings for all tracks to 1.

[ HIDI SETUP
Ci 1T =2 1 31

CHanner [ 1] - I
PRESET 1) v

PRESETS

Figure A.2 MIDI Settings window
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Other MIDI Tips

Layered Sounds: If you connect the sound output from C-64 to your stereo, boom box, or other amplification
equipment, you will immediately have better quality sound. Also, you can set the C-64 and MIDI to play at the
same time and thus build layered instruments. For example, you could have a synthesizer voice set to play on the
C-64 and a string instrument set to play on your MIDI instrument to create a layered synth-string sound
unobtainable with the C-64 or synthesizer alone.

MIDI Clock Sync: Instant Music sends out a MIDI sync signal that allows a drum machine or other MIDI
device with sync capabilities to play in time with Instant Music. Instant Music also controls the start and stop of
the synchronized instrument. To do this, enable your MIDI device to accept syne signals from Instant Music (refer
to your MIDI instrument documentation). To change drum patterns or tracks, you may have to turn off MIDI sync.
This will depend on the particular drum machine.

Ad
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APPENDIX B: INSTANT MUSIC CONCERT NOTES

Below is documentation about all songs provided with [nstant Music. The information contained here is for
advanced users who have a working knowledge of standard music notation and chord structure. Included are the
chord progressions for every song, as well as notes about most of the songs. Ideas are also included on how to
improvise with this song. Some of these ideas might be thought of as "global strategics,” which you can also use
clsewhere in Instant Music. Global strategies are marked with an asterisk (*).

Some Common Chord Progressions
Here are some common chords with C as the root.

C = C major = C-E-G

Cm = C minor = C-Eb-G
c7 = C dominant seventh = C-E-G-Bb
Cm7 = C minor seventh = C-Eb-G-Bb
Cdim = C diminished = C-Eb-Gb
Cdim7 = C diminished seventh =C-Eb-Gb-Bb

The next list contains chords which are more common in jazz than in rock and roll. If you are interested in the
spellings of 11th and 13th chords, consult a jazz textbook.

co7 = C half diminished = C-Eb-Gb-Bb
C17-5 = C seven, diminished fifth = C-E-Gb-Bb
C7+5 = C seven, augmented fifth = C-E-G#-Bb
C9 = C ninth = C-E-G-Bb-D
Cm9 = C minor ninth = C-Eb-G-Bb-D
Cmaj9 = C major ninth = C-E-G-B-D
C-9 = C diminished ninth = C-E-G-Bb-Db

Chord Progressions Used in Instant Music Songs

Rock Songs
1962 Fun: This two-chord progression is perfect for composing melody after melody. Build your own wall of
sound! *Try alternating a sustained accompaniment for one or two iterations of the tune with a rhythmic
background.

IGIGIEmI|Em:l

Beau Bop: Here is a classic rock progression in a 3/4 rhythm. *Try writing a bass solo to play off the piano
solo.
Il CIFIGTIE:
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C Minor Jive: Driving rhythm, pure and simple. In our version, guitar and bass are used in a percussive
manner.

Cm!ICmICmI!|Cm

CmICmICmI!G

I:Cm I FI1CmIF:l

Eighties Pop: Note the variations on a theme in the melody and bass lines of this piece.

I:ClAmMICIl Am :l
FIGIFIG

Fifties Fantasy: A number done in the classic fifties pop song progression and style. This song is one of
many Instant Music songs that can change drastically in mood with sharp shifts in tempo.

I:C/Am /| Dm7 /G7/:l
C/Am /| Dm7/G7/
C/EfIC/]Y
FIFmICICT
FI1FmID71G7

Frisco Vice: *Experiment with different instrument combinations.

ATIATICTICT
D71 D7 1 ET7T | E7

Good Groove: Relive Woodstock with this one!

CTIFICTIF
CTIFICTICT
FIFICTIF
CTIFICTIC?

Hey You: Turn this song into a 12 or 16 measure opus with the Copy and Pastc commands.
C///IBb/EY

Jamaican Jam: This song conlains a standard reggae accompaniment. An interesting compositional technique
to try here is a rising melody against the descending bass. Instant Bob Marley!

AmIAmIGIG
FIFIETIE7

B.2
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Lounge Lizard: Lounge Lizard has a nifty bass pattern,

:CICICIF:l
Am| Am I F71G7

Metallic Dream: An awesome jam song for you Twisted Sister fans.

AmlIAm|Am|Am
G71G7 |Em | Em
DIDICIC
BmIBmIEIE

Night Life: Here is one of the most thythmic tunes in [nstant Music. *Jamming with the bass is particularly
effective in this tune.

Em7 | A7 | Dmaj7 | Bm7
Em7 | A7 | Dmaj7 | Dmaj7

Night Out: Note the use of the chorus voice in the melody for this piece.
Il: D7 1 D71 D71CT:ll
D71D71D71C7
c71C7

I: D71D71D71CT:0
C71C7

Popsicle: Sure to cure the worst case of cold fect.

II: Bb7 | Bb7 | Eb7 | Eb7 | F7 1 IF7 :ll
Rock Chorale: The assymmetric meter of 5/4 only serves to underscore the simplicity of the basic structure in
this song. The two chords in this number form the basis of many great songs such as Layla, You Can't Always
Get What You Want, and the chorus in You've Got to Hide Your Love Away.

I C1E:
Rocking Flight: This one's sure to get you moving.

E71D71G71F7/B7/
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Samba: Written by Dan Silva (creator of DeluxePaint). This song features a hot percussion combo. Samba's
progression is a perfect example of the "circle of fifths”; A-D-G-C-F*-B-E.

Am7 / D7 /| Gmaj7 [ Cmaj7 /
7 /BT /I Em/ET/

Skiffle: This song illustrates the use of the skiffle rhythm, coupled with a great progression and descending bass
line. *Try changing the accompanying rhythm in the blue voice.

W:C///VAm [/ /VF/{ /1 Dm/G7/:l
Em I F I Em|A7
Dm7///1GT///VCIEJIGT/]]

Jazz/Blues Songs

Boogie Woogie: Boogie woogic is a classic style of blues improvisation. This is one of three blues
“templates” provided with Instant Music. These numbers bencfit greatly from finessing parts of the solos in free
mode, thus accessing all of the "blue” notes.

FTI1FTI1F7 | F7
Bb7 | Bb7 | F7 | F7
Cmaj7l Bb7 | F7 | F7

Jazz Blues: An arrangement of a classic jazz blues progression. What is the red voice doing?

Eb7 | Eb7 | Eb7 | Eb7
AbT | AbT | Eb7 | Eb7
Bb7 | Ab7 | Eb7 | Eb7

Jazz Waltz: Jamming with the counter melody (Red Voice) is especially rewarding in this song. This song
illustrates one of many variations on a blues progression, using tonic major seventh chords instead of dominant
sevenths.

Abmaj7 | Db7 | Abmaj7 | Ebm7 / Ab7

Dbmaj7 | Dbm7 | Cm7 | F7-9

Bbm7 | Eb7 | Abmaj7 | Abmaj7

Jeneric Jazz: This song has been especially designed for jamming in the scale mode.
Fmaj7 | Bb7 | Fmaj7 | Cm7 [ F7+5

Bbmaj7 | Bbm7 / Eb7 / | Am7 | A7-5
G©7 1 C7-9 | Fmaj7 / Abmaj7 / | Dbmaj7 / C /

B4
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Rock Blues: The 12-bar blues featurcs a piano quartet in a rocking rhythmic arrangement. This is an excellent
song to use the Quickdraw command. Click on the sixteenth note rhythm guide (for four notes per quarter beat)
and enter notes in Chord mode. Now, use the lower-right Quickdraw pattern (resulting in a triplet thythm). A
polyrhythmic effect results when you paste down a line.

CT1CTI1CT1CT
FT1F1i1Cri1C7
G7IF11C71C7

Folk Songs
Barn Dance: This tune is perfect for a gradual accelerando — slowly raise the tempo bar at each verse and
chorus. *Try duping the song and compose variations on the tune and countermelody.

A/lIING/EmG
Af//IGEmA/

Cajun: A spicy song in the style of traditional Cajun music.

AITATATA
AIAIEIE

E7 1 ET I ETIET
E7TIETIATA

Rosin the Bow: A traditional folk tune and all-round great drinking song.

EIEIEIA
EIEIEIB
EIEIGHmIA
EIB7TIEIE
EIEITATA
EIEIAIB
EIEIGHmI|A
EIB71AIE

Hornpipe: Well blow me down — if it isn't the renowned Irish fiddle tune.

ILGIGIAID
GIC/AIDIG:l
GICIAID
GIC/A/IDIG
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Classical Songs
Anitra's Dance: An cxcerpt from the Peer Gynt Suite by Edvard Grieg (1843-1907). Anitra's Dance is styled as
a classic mazurka — a waltz rhythm with a strong third beat.

Am|Am|Am|Am
Adim7 | Adim7 I F I B
Il: B ped | B ped :Il
Em|Em|Em/B7 | Em

Bach's Joy: From the cantata Jesu, Joy of Man's Desiring by Johann Scbastian Bach (1685-1750).

GIEm!|Am | D7
GlAmIAm CHdim D71 G
GIDICID7ID7
GIEmICD7/

GIEm | Am | D7

G | Em | Am C#dim D7 | G / C#dim
Dm/E71 Am7 | Dm/E7 | Am
Dm/E7 1 Am | Am | Dm /E7

Am

Bouree: Many of the suites by J.S. Bach were collections of dance music. A bouree is a French 17th-century
dance, with a quick duple (two-step) meter and a single upbeat.

Em/B7/IGBEm/IG///IB7/Em/
Em/B7/IG/Em/IG/D/IG//[/
D/G/IET/AmIET ///1 Am /D7 /
G/ET/IAm /D /IBm/F#T /1B /[/]
E7/A7/1D7/G7/1C/Fiim /IB7//[E7
Am /G /IF#fm /Em /IB7///IEm///

Mountain King: Another excerpt from Grieg's Peer Gynt Suite. This haunting theme was whistled by Peter
Lorre in Fritz Lang's M.

I: Am | Am | Am I C:ll
LEIEIEIE:l

Sabre Dance: Here we have Aram Khachaturian's memorable and exciting number from the Gayne ballet.

ll: Gmaj7 --> Bb7 Il

B.6
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Miscellaneous Songs
Greensleeves: The well-known traditional English ballad. It is written in the Dorian mode.

Key of G major
AMCIGEmIAmDIG Em
AmCIGEm|IAmEm | Am
CIGEmIAmDI|Em
CIGEm|AmEmI|Am

Frere Jacques: Here is the first of three rounds on /nstant Music. After a bit of experience with [nstant Music,
you will find that composing original rounds could not be casier. First, decide how many mcasures you want the
melody to be and display only that number of bars on the screen. Then, compose a melody, perhaps using your
own variation of one of the following rounds. Third, copy the color with the melody and scroll one or two
measures to the right.  Sclect another instrument, paste onto it, and repeat the process. If, after hearing the result,
you are not happy with the melody, just start from the beginning.

Jacques Deluxes: This song is also a round. Fully orchestrated and arranged, cverything is as it should
be--well, almost. The key has been changed from Eb to Eb minor. Look at the blue voice up close — *quick
changes in octave result in interesting color modulations without changing the instrument. The methods of
varying simple melodies in breathtaking ways are endless.

Le Grand Waltz: This song is reminiscent of French pop music from the 1960's, in the style of Yves Montand
and Michel Legrand.

l: Am7 | D7 | Gmaj7 | Cmaj7
F | Dm7 | Esus4 | E Il
AITEmIAIEm
AIGIDIE

Long Time Ago: An innocent song.

ClAm | Dm71G7
Cmaj7 | Am7 | Dm7 | G7
FIF|Cmaj71C7
FI1F1G7/Ab7 /[/1GT

Row Your Boat: Another popular round. Interesting to nole is the symmetrical pattern of notes on the screen.
How does the graphic form of the song onscreen relate to its aural form?

Comin' Round: This traditional American song offers a perfect opportunity to sharpen one's arranging chops.
A clear harmonic background, familiar melody and counter-melody.

FIFIFIF
FIFICIC?
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CICTIFIF
Progressions

The following 22 chord progressions offer you the chance lo explore music making under somewhat more
controlled and focussed conditions, *Combine your favorite arranged progressions (or even individual tracks for
that matter) into a full-fledged song. *Keep a disk of your own progressions, snippets, and works-in-progress.
Rock One: C/FI1IG/]]

Rock Two: Dm/C/IBb//C

Rock Three: Similar to House of the Rising Sun

ATIVCHIINDITITEST]

Rock Four: G///IBb{/HICIIIVGI]]
Rock Five: Fr1IVGJ1Y
Rock Six: Bb///1Ab/]]

Rock Seven: Samec progression used in Jamaican Jam. Flrst used more than three centuries ago, this
progression was also used in So Happy Together.

Am/[/IVGHIVELTIVET ]

Rock Eight: A very popular progression, it formed the basis for Baba O'Reilly.
F//CIBb///

Rock Nine: The standard fiftics progression.

C/Am/IF/GT7/

Rock Ten: A popular progression that is probably best known as the introduction to The Beatles', Michelle.
Dm / Dm/C# /| Dm/C [ Dm/B /| Bbmaj7 // /1 AT [ [/

Rock Eleven: Cm / Cm7 / IAbmaj7 [ G7 /

B.8
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Rock Twelve: This song uses the same progression as The Beatles', Dear Prudence.
C/C7 /1 Am7 [ Abmaj7 /

Rock Thirteen: G/Bm/IC/D/

Rock Fourteen: Used in Swnmer Loving from the movie Grease.

D/G/IA/G/

Jazz One: A standard progression utilizing the circle of fifths.
Em7//NAT//1DmT /1 1IGT ]
Jazz. Two: Used in Day by Day.
Fmaj7 / /| Bbmaj7 / /
Jazz Three: Ebmaj7 [/ /1 CT [/ /IBT /[ /1BbT )/
Jazz Four: Gmaj7 / /| Bbmaj7 / /| Ebmaj7 / /1 D7 //
Jazz Five: Every two measures modulates down one half step.

Dm7 / G7 /| Cmaj7 // /| C#mT [ T#7 /| Bmaj7 / [/
Cm7 / F7 [/ \Bbmaj7 // /1 Bm7 /E 7 [ |Amaj7 [ |/

Jazz Six: FAmO [/ /1 Gmaj9 /[ //
Jazz Seven: Dmaj / / /I EbCT f//VEmT [/ /VAT ]/
Jazz Eight: Amaj7 / / /| Bbmaj7 /
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APPENDIX C: SUMMARY OF KEYBOARD SHORTCUTS

Note: Keyboard shortcuts should not be used when using a mouse. Do not hold down the joystick
button while using keyboard shortcuts.

Screen Control Shortcuts

Spacebar
E7

F1

F3

F5

Q

Starts and stops the music
Toggles jamming on and off
Selects the green instrument
Selects the red instrument
Selects the blue instrument
Toggles Quickdraw on and off

Menu Command Shortcuts

ZX.CV
L
S
G

Shift-C

Jamming Shortcuts
o}
P

F
F1
F3
F5
T (Shift-cursor key)

4 (cursor key)

—

Scelect the Quickdraw patterns

Brings up the Load window so you can load songs from disk

Saves the loaded file to disk under the current file name

Brings up the Set Guides window for selecting pitch and rhythm
guides.

Opens and closes the Scale Ruler

Selects Score Rhythm

Sclects Preset Rhythm

Selects Free Rhythm

Brings up the Synthesizer for customizing instrument sounds

Brings up the MIDI Settings window

Brings up the Control window for selecting joystick or mouse.
Pressing Return automatically sclects mouse.

Selects Score Rhythm

Selects Presct Rhythm to use the number keys 1-0 to jam in presct
rhythms

Selects Free Rhythm

Sclects the green instrument

Sclects the red instrument

Selects the blue instrument

Raises the pitch for all tracks a half step. Changes the sound, not
the display.

Lowers the pitch for all tracks a half step if the pitch was raised
using the up arrow cursor key.

Rescts the pitch for all tracks to the normal setting.

Cl1
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It's Only Rock 'm' Roll!

Introduction

Welcome to It's Only Rock 'n' Roll! These extra twenty-five songs have been added to your disk to
offer extra jamming and composing opportunities. You're sure to find some favorite riffs and progressions
among these songs.

We've broken down the various periods of rock & roll into eight broad categories:

Drawer Title Contents

Memphis 1956: Early 50's rhythm and blues, early rock
Philadelphia 1959: Late 50's pop and carly 60's beat
Detroit 1962: The Motown sound

Chicago 1965: Rock blues

San Francisco 1968: The SF sound, acid rock

Los Angeles 1971: Heavy Metal

London 1974: Progressive rock

New York 1977: New Wave

As you look through the songs we've grouped under each of these categories, you will find that the categories
are very broad and contain songs that don't quite fit the title. For instance, we included the surf music of
California in the 1960's under (gulp) Philadelphia 1959. And, though many metal bands came from
California, some of the finest were British, as were many of the bands that led the way to heavy metal
(Cream, for instance). Moreover, progressive rock can be traced to the Beatles' Sgt. Pepper’s Lonely Hearts
Club Band of 1967, while in 1986, we have still not scen the end of "art rock." So, think of the category
names as loose tags which should indicate a musical feeling, rather than a strict period in the development of
rock. You will find an essay introducing each category and setting the group of songs in its historical
context.

The interactive composition tools of Instant Music are perfectly suited to the creation of almost any kind
of music — on the spot.

And if you find yourself just jamming in Instant Music, lean back and enjoy.

Memphis 1956

Rock and roll began as a street rebellion against the pretentiousness and hypocrisy in Fifties society,
establishment pop, and high art in general. "Roll Over Beethoven" by Chuck Berry epitomizes the feelings
rock fans had for classical music at the time. In the middle of the Eisenhower era, the Cold War, and
McCarthyism, rhythm & blues (formerly called "race records” because black musicians created the music) were
being bought in unprecedented numbers — and by white teenagers. Rock and roll was born when white
America discovered rhythm and blues.



In the beginning there was Chuck Berry. And he was good — very good. Considered by many to be the
greatest rock and roller ever, he synthesized country and western music and the blues tradition into a unique
sound that has been imitated by bands from the Beatles to the Beach Boys. His palette of guitar riffs came to
define what rock and roll was all about.

While Berry's first #1 hit came in 1955, Elvis Presley made his big splash one year later. He had begun
recording at Sam Philip's tiny Memphis studio in 1954; at Sun Records, Elvis developed his rockabilly sound
that took the world by storm. In 1956 he had five number 1 hit records. Presley's song "Heartbreak Hotel"
topped the Country and Western, Rhythm and Blues, and Pop charts simultaneously. Two years later,
Billboard initiated its Hot 100 chart, thus eliminating all the obsolete categorics. Rock and roll was a
synthesis of all of these styles.

1. Baby, Baby, Baby
A7 | A7 | A7 | A7 D7 | D7 | A7 | A7 E7 | D7 | A7 | A7

2. Let's Go Out
Ab / Fm / | Db [/ Eb7 /

3.  Memphis City
F7 | F7 | F7 | ¥7 Bb7 | Bb7 | F7 | F7 C7 | Bb7 | F7 | F7

Philadelphia 1959

In the late 1950s, the music industry began to mature. Rock went through some tragic growing pains in
1959 with the death of Buddy Holly (memorialized in the song "American Pie" by Don McLean). In this
same year, Chuck Berry was convicted under the Mann Act of transporting a minor across state lines for
immoral purposes, Alan Freed was fired by ABC when the federal government stepped up its investigation
into disk-jockey payola, and Elvis was still in the army.

Buddy Holly and the Crickets institutionalized the four-picce band we have all come to know and love. Holly
was also the first rock artist to play, almost exclusively, original material, instead of covering well-known
R&B tunes. He entered the production process itself and did his own arrangements.

In addition to Holly, one other figure was pivotal during the maturing process rock was going through,
Bridging the carly period of rock and that which was to come in the 1960's was the powerful presence of Phil
Spector. He brought us the "Wall of Sound." Using multitracking and other techniques, Spector assembled
armics of musicians to get the exact result he wanted. His records were the loudest recordings the rock world
had yet heard. Phil Spector began producing hits at the age of 19; three years later he had racked up 20 of
them. He was a millionaire at the age of 21. After a record of his flopped, Spector retired — he was 25,
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The early 1960's marked the beginning of a number of dance crazes spreading across the US. The Twist was

the first big one in 1961. Others, maybe not so memorable, included the Alley Cat, the Limbo, the
Locomoltion, and the Mashed Potato.

California beach music had its roots in this era. Formed in 1961, the Beach Boys began their string of
national hits in 1962 with "Surfin' Safari." This group almost single-handedly created California rock; their
songs dealt primarily with an idealized west coast teenhood, which was composed of equal parts surfing, fast
cars, and dating. Musically, the Beach Boys emphasized tight vocal harmonies, classic R&B guitar licks,
and a growing fascination with studio recording tricks.

1. Tighter
E | C#m | E | C#m A/B7/|E|A/BT/|E

2. Cowabunga
It E7 | E7T | A | Az l: F 1 G| A|A:

3. Prom Night
C|C | Am | Am F|F|G7]|G7

4. Another Night

Detroit 1962

The early 1960's saw the rise of one of the most successful recording studios ever: Motown Records. The
brain-child of Berry Gordy, it was the first major black-owned and black-operated label.

What Gordy managed to do was fuse gospel music and pop lyrics — and he did it very well. In 1966 (the
midpoint of Motown's Golden Decade, 1962-1971), 75% of all the records released by Motown made the
charts. One reason for the huge popularity of the Motown sound, for better or for worse, was the assembly
line production process and its reliance on standard formulas. In this respect, Motown's method was similar
to the studio system in Hollywood during the 1930's and 1940's.

A major key to Berry Gordy's success was the songwriting team of Lamont Dozier, Brian Holland and Eddie
Holland, as well as other writers such as Norman Witfield. Added to Motown's roster of artists was a
magnificent collection of the finest black and white studio musicians; they made the music really live. James
Jamerson and Carole Kaye put down some of the most legendary bass lines ever heard.

Concurrent with the rise of Motown was the rise of soul music at Atlantic record and the business of soul
music was salvation. Soul music showed a stylistic purity and down-home approach coupled with a distinct
church feel. It is a singularly optimistic and good-hearted music. The major soul artists who recorded in the
mid-sixties were Solomon Burke, Wilson Pickett, Joe Tex, Aretha Franklin, and Percy Sledge. Percy Sledge's
1966 hit, "When a Man Loves a Woman" possesses the quintessential soul sound: soaring vocals and church
organ.
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1. Higher
Am | Am | Am | D

2.  Slow and Soulful
It G|Em|C/D7/|GCG D7 ¢ Em/A/|Em/A/|C/D7/|G/B7/
Em/A/|Em/A/|C/D7T/]|GCG Am7

3. Papa Was: This arrangement pits a rock steady rhythm section against the syncopated green and red
voices.

4. Funky Blues

Dm | Dm | Dm | Dm Gm | Gm | Dm | Dm Am | Gm | Dm | Dm
5. Saint Soul

l: Em | D | G| D Bm7 | Cm7 | Bm7 | E9 Am7 | D7 | G| G ¢
Em | D | Em | D Em | D | C | Bsus4 / B /

Chicago 1965

The Rolling Stones, formed in 1962, was the first broadly popular and musically effective British blues
group. Brian Jones began playing blues guitar in 1960; the Stones later grew out of a trio Jones had started
called Blues, Inc.

After their early success, a number of blues bands started up in the UK. Probably the best of these was the
Yardbirds, who at one time or another, featured Jeff Beck, Jimmy Page, and Eric Clapton. It was Clapton
who left to join John Mayall's Bluesbreakers. In 1966, he formed Cream with Ginger Baker and Jack Bruce.

American folkies were quite suspicious of a white musician playing the blues. They worshipped
"Authenticity." Ignoring all of this were two white kids from Chicago: Paul Butterfield and Michael
Bloomfield. Butterfield had grown up in Chicago listening to and learning from many of the resident
bluesmen including Muddy Waters. His band, the Paul Butterfield Blues Band, was committed to playing their
material as faithfully as possible. Fellow Chicagoan Michael Bloomfield leamned to play blues guitar and
piano by backing older local bluesmen. Joining Butterfield's band, Bloomfield later turned down an offer to
join Bob Dylan's band, though the group backed Dylan at the infamous Newport Folk Festival in 1965,

1. Mellow in Minor
Fm (Bb) | Fm | Fm | Fm Bbm (Eb) | Bbm | Fm | Fm C7 | Bb | Fm | Fm

2. Get Down
F7 | F7 | F7 | F7 Bb7 | Bb7 | F7 | F7 C7 | Bb7 | F7 | F7

3. Boogyin'
F7 | Bb7 | F7 | F7 Bb7 | Bb | F7 | 7 Eb7 D7 Ab7
G7 | C7 | F7 Eb7 D7 Ab7 | G7 Db7 C7 Gb7
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San Francisco 1968

The San Francisco sound is representative of a number of forces that began to impinge upon rock music in
the 1960's. From recording technology and drugs, to the anti-war movement and its whole social
atmosphere, the music of this era embraced everything. Rarely has there ever been a musical period as
spontancously creative and experimental as the second half of that decade.

The lyrics were light years away from those of songs written just a few years earlier, e.g. "I met him on a
Monday and his name was Bill. / Da doo Ron Ron Ron da doo Ron Ron." In John Lennon's "I Am the
Walrus," the influence of LSD on the lyric content was practically unmistakable. Drugs influenced both ends
of the creative process — writing and listening.

Musically, many barriers were disappearing. By this time, the Beatles had pretty much laid to rest the 32-bar
pop standard form. “Revolution" contains the odd 2/4 measure thrown into a predominantly 4/4 meter. The
Grateful Dead were to carry this trend to the nth degree. Different instruments were being used for the first
time; George Harrison of the Beatles and Brian Jones of the Rolling Stones introduced the rock world to the
sitar, a traditional Indian stringed instrument. And electronic sounds were being exploited for their
possibilities as fast as technology could churn them out.

The influence of rapidly advancing studio technology is inestimable; after all, a band could do in a studio
what would be impossible in concert. The Beatles retired from concertizing in 1966 to work and record
exclusively in Parlophone’s Abbey Road studio.

1. Shades of Blue
CT | CT | €T | €7 F7 | F7 | C7 | C7 G7 | F7 | CT | C7

2. Lady
Am | D

3. Where
Am | G | F | E7

Los Angeles 1971

With names like Blue Cheer, Blue Oyster Cult, Deep Purple, Black Oak Arkansas, Black Pearl, and of course,
Black Sabbath, heavy metal burst on the rock scene in the late sixties. Given the numerous musical
sub-trends that were developing in the middle of the decade, it was perhaps inevitable, maybe cven necessary,
that this phenomenon should spring into being.

The precursors lo heavy metal were some of the famous British bands of the mid-sixties: the Who, the
Yardbirds, and Cream. These bands played hard rock. The music was loud, aggressive, and often featured
virtuoso guitar players. These were innovative groups, greatly enlarging the world of rock blues.



The first mutterings of heavy metal were heard in California around 1968 as Blue Cheer, Black Pearl and Iron
Butterfly appeared on the scene. They were at once post-psychedelic, post-Hendrix and very experimental.
Iron Butterly was most known at the time for its 17-minute cut, "In-A-Gadda-Da-Vida," which featured a 2 1/2
minute drum solo. Blue Cheer, named for an especially high-powered strain of LSD, came out of the acid rock
mecca of San Francisco.

But it was Britain that proved to be the source of one of history's most popular rock groups: Led Zeppelin.
This was the band that finally replaced the Beatles as the most popular group in the U.K. and went on to
define what heavy metal was all about. Yes, they were loud, and yes, they dealt with many of the subjects
which caused heavy metal to be so roundly criticized (satanism, among others). But out of all the heavy
metal bands to emerge, Led Zeppelin's sound had finesse. Through the music sensibility and production
skills of ex-Yardbird Jimmy Page, Led Zeppelin was simply the best at what they did. Nobody used
distortion as well or in as many varied ways as Page, with the sole exception of Jimi Hendrix.

1. Dark Invader: This song is heavily layered and much of its unique sound is accomplished by
abandoning guides. You'll notice that some measures have no chord guides.

London 1974

This category concentrates on progressive and art rock. Though most of the performers in these camps
flourished in the 1970's, this movement had its roots in the 1960's with much of what the Beatles did. From
Sgt. Pepper’s Lonely Hearts Club Band through Abbey Road, their music took the definition of rock and roll
to its limit, and then some. Compare two songs written just a few years apart: “I Saw Her Standing There"
and "Revolution 9." While the former is a classic rock & roll tune, the latter is a tape collage with
absolutely no reference to a key or blues base. Self-consciousness was beginning 1o insert itself into the
creative process.

Art rock often parallels, parodies, or imitates other "higher" art forms. For reasons beyond the scope of this
essay, many of the bands that used classical music as their primary inspiration came from Britain: the Nice;
Emerson, Lake, and Palmer; Rick Wakeman; Renaissance; and Yes. Musically speaking, their classical
imitations and mythological epics were of questionable success, and did not always rise above their own
pretentiousness.

But some genuinely creative work was appearing ncvertheless.  Rock operas like Tommy were not
constrained to just quote the classics. Various non-rock styles were used to great success by many bands
(e.g. the use of Middle Eastern scales in Led Zeppelin's "Kashmir"). Moreover, the move toward
incorporating music of all types and from all culiures was gaining ground through the efforts of Roxy
Music, Genesis, David Bowie and King Crimson. Shifts among wholly different styles of music became
common, coupled with tempo and volume modulations. Frank Zappa is a master of creating varied musical
collages.

But is any of this really rock? Strictly speaking — we won't say, But compositions such as "Revolution 9"
were writlen with a rock sensibility and were aimed at a rock audience. The overly omate examples of
progessive rock were eventually rejected, and thus began new wave primitivism.

R.6



R.7

1. Courtly Circumstances
Dm / Dm7 | Bdim / Bb7 /

2. All Here
Cm7

New York 1977

All in all, 1977 was a great year for records; the Sex Pistols, the Talking Heads, Elvis Costello, the Clash,
and the B-52's all released their first albums. The Sex Pistols made what was to be their first and last tour of
the U.S. Punk rock was off and running, and new wave was not far behind. The music that was emerging
from Manhattan clubs such as C.B.G.B's (Country, Blue Grass, and Blues) had been gaining attention since
1975; the bands playing these downtown venues included Patti Smith, the Ramones, Television, and
Blondie.

Much of this music existed in direct opposition to the predominantly British "progressive” rock scene, which
was, perhaps, a tad overblown. New Wave proclaimed that art did not necessarily imply complexity or
virtuosity. To those raised on the smooth harmonies of the late Beatles and Genesis, as well as the
pyrotechnics of Emerson, Lake and Palmer, the raw and out of tune sounds of bands like Devo and the B-52's
must have sounded like armageddon.

So much of what became a major outpouring of original music in 1977 can be traced back to the work of one
band created in New York in 1965: the Velvet Underground, featuring Lou Reed and John Cale. This band
nurtured the new wave sound, with its commitment to primitive sound, bizarre lyrics, and fascination with
other media.

1. Not A Plano
Em /D /| Cmaj7 / D/

2. Odeon
Dm7 | Dm7 | Cm7 | Cm7 F7 | F7 | G7 | G7

3. Underground
C|C|Am |G

4. Synth Head
Gm - F
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